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ABSTRACT: Authors of papers to proceedings have to type these in a form suitable for direct 
reproduction by the publisher. In order to ensure uniform style throughout the volume, all the 
papers have to be prepared strictly according to the instructions set below. The enclosed 
CPI_AR_PDF1.7.joboptions should be used to create the final Camera Ready Copy PDF file. 
The publisher will reduce the camera-ready copy to 75%. For the convenience of the authors, 
template files for MS Word 6.0 (and higher) are provided. 

1​ GENERAL INSTRUCTIONS 

1.1​ Type area 

The text should fit exactly into the type area (150 × 240 mm). For A4 size paper the margin 
settings are as shown in Table 1 and are set out in the template file B1PROCA4.dot. The letter 
size margins shown in Table 1. 

 
Table 1. Margin settings for A4 size paper and letter size paper. _______________________________________________________________ 
Setting​ ​ ​ ​ ​ A4 size paper​ ​ ​ ​ ​ Letter 
size paper​  ​ ​ ​ ​ ​ ​ ​ ________________​ ​ ​​ ________________​  
​ ​ ​ ​ ​ ​ ​ cm​ ​ inches​ ​
​ ​ cm​ ​ inches _______________________________________________________________ 
Top​ ​ ​ ​ ​ ​ 2.5​ ​ 0.98"​ ​ ​
​ ​ 1.75       0.69" 
Bottom​ ​ ​ ​ ​ 3.0​ ​ 1.18"​ ​ ​ ​
​ 2.01​ ​ 0.79"​
Left​ ​ ​ ​ ​ ​ 3.0​ ​ 1.18"​ ​ ​
​ ​ 3.28​ ​ 1.29" 
Right​ ​ ​ ​ ​ ​ 3.0​ ​ 1.18"​ ​ ​
​ ​ 3.28​ ​ 1.29" 
All other​​ ​ ​ 0.0​ ​ 0.0"​ ​ ​ ​ ​ 0.0
​ ​ 0.0" _______________________________________________________________ 

1.2​ Typefont, typesize and spacing 

Use Times New Roman 11 point size and 12 point line spacing (Standard text tag). Use roman 
type except for the headings (Heading tags), parameters in mathematics (not for log, sin, cos, ln, 
max., d (in dx), etc.), Latin names of species and genera in botany and zoology and the titles of 
journals and books which should all be in italics. Never use bold except to denote vectors in 
mathematics. Never underline any text. Use the small font (10 points on 11 points) for tables 
(Table tags), figure captions (Figure caption tag) and the references (Reference text tag). Never 
use letterspacing and never use more than one space after each other. 

2​ GETTING STARTED 

2.1​ The template file 

Copy the template file B1ProcA4.dot to the template directory. This directory can be found by 
selecting the Tools menu, Options and then by tabbing the File Locations. When the Word 

 



 

programme has been started, open the File menu and choose New. Now select the template 
B1PROCA4.dot and start by renaming the document after clicking Save As in the Files menu. 

2.2​ Title, author and affiliation frame 
Place the cursor immediately before the T of Title at the top of your newly named file and type the title of the paper in lower case (no caps except for proper names). The title should not be longer than 75 characters). Delete the word Title (do not delete the paragraph end). Place the cursor immediately before the A of A.B. Author(s) and type the name of the first author (first the initials and then the last name). If any of the co-authors have the same affiliation as the first   author, add his name after an & (or a comma if more names follow). Delete the words A.B. Author etc. and place the cursor immediately before the A of Affiliation. Type the correct affiliation;  Name of the institute, City, State/Province, Country, do not add street names, P.O. Box numbers or zip codes to the affiliations. Now delete the word Affiliation. If there are authors linked to other institutes, place the cursor at the end of the affiliation line just typed and give a return. Now type the name(s) of the author(s) and after a return the affiliation. Repeat this procedure until all affiliations have been typed.  All the above texts should fit in the frame which should not be changed (Width: Exactly 15.0 cm or 5,91"; Height: Exactly 7.2 cm or 2.79"; Lock anchor). 

2.3​ Abstract frame 

If there are no further authors, place the cursor one space after the word ABSTRACT: and type 
your abstract of not more than 150 words. The first line of the abstract will be 7.2 cm (2.83") 
from the top. The complete abstract will fall in the abstract frame, the settings of which should 
also not be changed (width: Exactly 15.0 cm or 5.91"; height: Automatic; vertical: 7.2 cm or 
2.83" from margin; Lock anchor). 

2.4​ First line of text or heading 

If your text starts with a heading, place the cursor immediately before the I of 
INTRODUCTION and type the correct text for the heading. Now delete the word 
INTRODUCTION and start with the text after a return. This text should have the tag First 
paragraph. 

If your text starts without a heading, you should place the cursor immediately before the I of 
INTRODUCTION, change the tag to First paragraph and type your text after deleting the word 
INTRODUCTION, but not the return at the end. 

3​ LAYOUT OF TEXT 

3.1​ Text and indenting 

All text, figures, tables, etc. should fit exactly in the type area of 15 × 24 cm (5.91" × 9.52"). All 
text should be typed in Times New Roman. All text is 11 pt on 12 pt line spacing except for the 
paper title (16 pt on 18 pt), author(s) (12 pt on 13 pt), affiliation(s) (10 pt on 11 pt) and the small 
text in tables, captions and references (10 pt on 11 pt). All line spacing is exact. Never add a line 
space between lines or paragraphs. 

First lines of paragraphs are indented 4 mm (0.16") except for paragraphs after a heading or a 
blank line (First paragraph tag). Equations are indented 12 mm (0.47") (Formula tag). 

3.2​ Headings 

Type primary headings in capital letters roman (Heading 1 tag) and secondary and tertiary 
headings in lower case italics (Headings 2 and 3 tags). Headings are set flush against the left 
margin. The tag will give two blank lines (24 pt) above and one (12 pt) beneath the primary ​
headings, 1½ blank lines (18 pt) above and a ½ blank line (6 pt) beneath the secondary headings 
and one blank line (12 pt) above the tertiary headings. Headings are not indented and neither are 
the first lines of text following the heading indented. If a primary heading is directly followed 
by a secondary heading, only a ½ blank line should be set between the two headings. 
In the Word programme this has to be done manually as follows: Place the cursor on the primary 
heading, select Paragraph in the Format menu, and change the setting for spacing after, from 12 
pt to 0 pt. In the same way the setting in the secondary heading for spacing before should be 
changed from 18 pt to 6 pt. 

3.3​ Listing and numbering 

For listing facts, use either the style tag List summary signs or the style tag List number signs. 

 



 

3.4​ Equations 
Use the equation editor of the selected word processing programme. Equations are indented 12 mm (0.47") from the left margin (Formula tag). Number equations consecutively and place the number with the tab key at the end of the line, between parantheses. Refer to equations by these numbers. See for example Equation 1 below: 

  From the above we note that sin θ = (x + y)z or: 

​ (1) 
where ca = interface adhesion; δ = friction angle at interface; and k1 = shear stiffness number. 

3.5​ Tables 

Locate tables close to the first reference to them in the text and number them consecutively. 
Avoid abbreviations in column headings. Indicate units in the line immediately below the 
heading. Explanations should be given at the foot of the table, not within the table itself. Use 
only horizontal rules: One above and one below the column headings and one at the foot of the 
table (Table rule tag: Use the Shift-minus key to actually type the rule exactly where you want 
it). For simple tables use the tab key and not the table option. Type all text in tables in small 
type (Table text tag). Align all headings to the left of their column and start these headings with 
an initial capital. Type the caption above the table to the same width as the table (Table caption 
tag). See for example Table 2. 

3.6​ Figure captions 
Always use the Figure caption style tag (10 points size on 11 points line space). Place the      caption underneath the figure (see example in Section 4). Type as follows: ‘Figure 1. Caption.’ Leave about two lines of space between the figure caption and the text of the paper. 

 
Table 2. The number of officially reported plague cases in the world. _____________________________________________________________________________ 
Region*​​ ​ 1968​ ​ ​ 1970​ ​ ​ 1972​ ​
​ 1974​ ​ ​ 1976​ ​ ​ 1978 _____________________________________________________________________________ 
Africa​ ​   ​   172​ ​     ​     27​ ​     ​     85​  ​   
​   128​ ​   ​   183​ ​     ​     77 
America​​   ​   392​ ​   ​   326​ ​   ​   301​ ​   
​   297​ ​   ​   321​ ​   ​   142 
Asia​ ​ ​ ​ 4395​ ​ ​ 4111​ ​ ​ 2312​
​ ​ 1408​ ​ ​ 2230​ ​   ​   518 
Total​ ​ ​ ​ 4959​ ​ ​ 4464​ ​ ​ 2698​
​ ​ 1833​ ​ ​ 2734​ ​   ​   737 _____________________________________________________________________________ 
*For Europe only one reported case in 1970. 

3.7​ References 

Please, use references style Cite Them Right 10th edition- Harvard 
In the text, place the authors’ last names (without initials) and the date of publication in 
parentheses (see examples in Section 3.7.1). At the end of the paper, list all references in 
alphabetical order underneath the heading REFERENCES (Heading without number tag). The 
references should be typed in small text (10 pt on 11 pt) and second and further lines should be 
indented 4.0 mm (Reference text tag). If several works by the same author are cited, entries 
should be chronological: Larch, A.A. 1996a. Development ... Larch, A.A. 1996b. Facilities ... Larch, A.A. 1997. Computer ... Larch, A.A. & Jensen, M.C. 1996. Effects of ... Larch, A.A. & Smith, B.P. 1993. Alpine ... In bibliographies the order for books and journals are respectively:  Last name, First name or Initials (ed.) year. Book title. City: Publisher. Last name, First name or Initials year. Title of article. Title of Journal (series number if necessary) volume number (issue number if necessary): page numbers. 

3.7.1​ Examples: Grove, A.T. 1980. Geomorphic evolution of the Sahara and the Nile. In M.A.J. Williams & H. Faure (eds), The Sahara and the Nile: 21-35. Rotterdam: Balkema. Jappelli, R. & Marconi, N. 1997. Recommendations and prejudices in the realm of foundation engineering in Italy: A historical review. In Carlo Viggiani (ed.), Geotechnical engineering for the preservation of monuments and historical sites; Proc. intern. symp., Napoli, 3-4 October 1996. Rotterdam: Balkema. Johnson, H.L. 1965. Artistic development in autistic children. Child Development 65(1): 13-16. Polhill, R.M. 1982. Crotalaria in Africa and Madagascar. Rotterdam: Balkema. 

3.7.2​ Endnote 
We would appreciate it if you make use of the enclosed Endnotes stylefile (Harvard.ens). 

 



 

3.8​ Notes 

These should be avoided. Insert the information in the text. In tables, the following reference 
marks should be used: *, **, etc. and the actual footnotes are then set directly underneath the 
table. 

3.9​ Conclusions 

Conclusions should state concisely the most important propositions of the paper as well as the 
author’s views of the practical implications of the results. 

4​ PHOTOGRAPHS AND FIGURES 

Number figures consecutively in the order in which reference is made to them in the text, 
making no distinction between diagrams and photographs. Figures should fit within the column 
width of 90 mm (3.54") or within the type area width of 187 mm (7.36"). Paste copies of figures, photographs etc. at the required size onto the typescript where you want them to appear in the text. Do not place them sideways on a page. Figures, etc. should not be centered, but placed against the left margin. Leave about two lines of space between the actual text and figure (including caption). Never place any text next to a figure. Leave this space blank. The most convenient place for placing figures is at the top or bottom of the page. Avoid placing text between figures as readers might not notice the text. Line drawings (as well as photographic reproductions of these) should be in black (not grey) on white. Keep in mind that everything will be reduced to 75%. Therefore, 9 point should be the minimum size of the lettering. Lines should preferably be 0.2 mm (0.1") thick. Keep figures as simple as possible. Avoid excessive notes and designations.  

 
 
Figure 1. Caption of a typical figure. 

5​ PREFERENCES, SYMBOLS AND UNITS 
Consistency of style is very important. Note the spacing, punctuation and caps in all the examples below. 
−​ References in the text: Figure 1, Figures 2-4, 6, 8a, b (not abbreviated) 

−​ References between parentheses: (Fig. 1), (Figs 2-4, 6, 8a, b) (abbreviated) 

−​ USA / UK / The Netherlands instead of U.S.A. / U.K. / Netherlands / the Netherlands 

−​ Author & Author (1989) instead of Author and Author (1989) 

−​ (Author 1989a, b, Author & Author 1987) instead of (Author, 1989a,b; Author and Author, 
1987) 

−​ (Author et al. 1989) instead of (Author, Author & Author 1989) 

−​ Use the following style: (Author, in press); (Author, in prep.); (Author, unpubl.); (Author, 
pers. comm.)  Always use the official SI notations: 

−​ kg / m / kJ / cm instead of kg. (Kg) / m. / kJ. (KJ) / cm.;  

 



 

−​ 20°16′32′′SW instead of 20° 16′ 32′′ SW 

−​ 0.50 instead of 0,50 (used in French text); 9000 instead of 9,000 but if more than 10,000: 
10,000 instead of 10000 

−​ 14C instead of C14 / C-14 and BP / BC / AD instead of B.P. / B.C. / A.D. 

−​ 20 instead of ×20 / X20 / x 20; 4 + 5 > 7 instead of 4+5>7 but –8 / +8 instead of – 8 / + 8 

−​ e.g. / i.e. instead of e.g., / i.e., 

6​ SUBMISSION OF MATERIAL TO THE EDITOR 
The camera-ready copy PDF file of the complete paper should be created with the enclosed CPI_AR_PDF1.7.joboptions file and sent to the editor together with the MS Word file. All figures should be included as high resolution images in the PDF file (see artwork document for resolution requirements). Check whether the paper looks the same as this sample: Title at top of first page in 18 points, authors in 14 points and all other text in 11 points on 12 points line space, except for the small text (10 point on 11 point line space) used in tables, captions and references. Also check if the type width is 187 mm (7.36"), the column width 90 mm (3.54"), the page length is 272 mm (10.71") and that the space above the ABSTRACT is exactly as in this sample. 
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